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Introduction 
 

COBie is the abbreviation of Construction Operations Building Information Exchange, a specification used in 
the handover of Facility Management information. It is a spreadsheet data format for the delivery of a 
subset of building model information, rather than geometric model information. 

Although GRAPHISOFT ArchiCAD cannot export COBie spreadsheets directly, ArchiCAD’s BIM-quality models 
and IFC data exchange capabilities produces data output that is easily converted into COBie documentation, 
with the help of free or commercial conversion programs. 

What is the relationship between IFC and COBie? 

The COBie spreadsheet is a mapping of the Basic FM Handover View Definition, which is a subset (so-called 
“Model View Definition”; MVD) of the current IFC 2x3 scheme. Basic FM Handover View Definition was 
developed by buildingSMART to exchange facility management information among building models. 
ArchiCAD’s IFC 2x3 interface and database support the IFC data and model export requirements of the Basic 
FM Handover View Definition, so most of the values of the COBie spreadsheet cells are extracted from IFC 
models exported by ArchiCAD according to the Basic FM Handover MVD settings. 

Hint For more information about the relationship between IFC 2x3 Basic FM Handover MVD and COBie, 
visit the buildingSMART website by clicking here. 

This paper provides practical information on which data to add to an ArchiCAD project and how to export it 
as an IFC model, to obtain a format suitable for producing a COBie2 spreadsheet. (The current version of 
COBie is 2.4.) The final chapter consists of a sample workflow using a free IFC → COBie conversion tool 
recommended by buildingSMART. 

Hint For detailed documentation about ArchiCAD’s IFC capabilities, read the ArchiCAD Help 
documentation or read the IFC2x3 Reference Guide. 

Note This documentation was written based on the currently available COBie – IFC mapping rule called 
“Responsibility Matrix version 17” (published 30th April 2013). 

  

http://www.buildingsmart-tech.org/specifications/ifc-view-definition/fm-handover-aquarium/fm-aquarium-cobie2-description/fm-aquarium-cobie2-description
http://www.graphisoft.com/downloads/addons/ifc/index.html
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ArchiCAD Model Preparation for COBie2 
 

The Basic FM Handover View Definition used by COBie2 queries the following IFC data types from an 
architectural model and/or its elements: 

- Owner History data 
- IFC Attributes 
- IFC Properties (standard IFC 2x3 and custom COBie2-required properties) 
- IFC Classification Reference data 
- IFC Type Product entities 
- IFC Zone assignments 
- IFC System assignments 
- Base quantities 
- Space containment relation 
- Space boundary relation 

All of these data types are available in ArchiCAD as native ArchiCAD data. It is worth using ArchiCAD’s 
predefined COBie scheme: this filters the IFC standard database to show, throughout the user interface, only 
those data fields required by COBie. Thus, both at the element level (in Element Settings dialog boxes) and at 
the project hierarchy level (in IFC Manager), you will display and fill out only the data fields that are relevant 
for COBie. This predefined scheme also defines the Category definitions for each entity type. 
 

 
Figure 1   COBie scheme-driven data management 

So, to display the COBie2-required and relevant IFC data in IFC data management dialogs, load one of the 
proper “COBie2(…).xml” scheme template files into the ArchiCAD project with the IFC Scheme Setup 
command (File > File Special > IFC 2x3). 
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Note The reason there are multiple COBie 2 scheme files is that the Category definitions required by 
COBie use different classification standards in different countries. For example, the U.S. uses the 
OmniClass standard to categorize Facility, Space and Type, while the UK uses Uniclass. (In the case of 
Uniclass 1.4, a given Category may use multiple classification tables.) Obviously, you should fill out 
only one Classification Reference data (since COBie requires one data) – the one which best 
expresses the Category definition required by COBie for the specific element. 

 

Figure 2   COBie-required properties loaded as a scheme template 

In the IFC data management dialog boxes, click the “Show only Scheme items” icon  to filter the full IFC 
database to show only the loaded COBie scheme data. If this icon is activated, all data that are not part of 
the scheme definition are hidden on the interface: this helps you to fill out only the data relevant for COBie. 
For example, data inherited from ArchiCAD that are not part of the COBie scheme (such as Load-Bearing, 
Position, Renovation status) will be hidden. The same is true of application-specific, custom IFC data which 
were added earlier to the project as a result of model exchange with other applications (e.g. structural or 
MEP), but which are irrelevant for COBie. 

  



7 
 

The following chapters summarize the data (required from a design application) to be provided in ArchiCAD 
for use by the COBie2 spreadsheet. 

 

Figure 3   The worksheets of the COBie2 spreadsheet 

Key to tables displayed in the following sections of this document: 

 COBie2 data taken directly from data that was input in ArchiCAD. In other words, the 
ArchiCAD and IFC data types corresponding to these COBie data must be set or created in 
the ArchiCAD model. 
 

 COBie2 data that are automatically extracted from the ArchiCAD model, project settings 
and their IFC export. In other words, these COBie data are set automatically in ArchiCAD; 
no extra data definition is required from the ArchiCAD user. 
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Contact 
The COBie2 Contact worksheet summarizes the person and organization data of the project / model 
designer. 

 

Figure 4   Mapping between ArchiCAD model data and the COBie2 Contact worksheet data 

ArchiCAD project data must be assigned to correspond with the COBie2 items marked in green. All “Contact” 
data can be entered in ArchiCAD’s Project Info (File > Info) dialog box. 

 

Figure 5   Contact data in ArchiCAD (Project Info) 
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Facility 
The COBie2 Facility worksheet summarizes the Facility (IfcBuilding), the Project (IfcProject) and the Site 
(IfcSite) data. 

 

Figure 6   Mapping between ArchiCAD model and the COBie2 Facility worksheet data 

All major Facility data can be defined in the Project Info dialog (File > Info). These data can also be managed 
in the IFC Manager as the main Attributes of the IfcProject, IfcSite and IfcBuilding entities. 

 

Figure 7   Facility data in ArchiCAD (Project Info) 
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To set the Facility “Category”, provide the proper Classification Reference value in the IFC Manager. COBie 
requires IfcBuilding classification by OmniClass table 11, entitled “Construction Entities by Function” (in US) 
or by the Uniclass system (in UK). Both systems are available as built-in classification rules in ArchiCAD under 
the Apply Predefined Rule option in the IFC Manager. 

 

Figure 8   COBie Facility Category set by the proper OmniClass or Uniclass classification system (IFC Manager) 

The COBie-required unit systems of the Facility can be set at Export Options. There is a predefined settings 
package (so-called “IFC Translation Setup” in ArchiCAD) which contains export options optimized for the 
COBie-required IFC export. It is called “COBie 2 Export” IFC Translator (see chapter COBie2-enabled IFC 
Model Export). 
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Floor 
The COBie2 Floor worksheet summarizes data of the building stories (IfcBuildingStorey). 

 

Figure 9   Mapping between ArchiCAD model and the COBie2 Floor worksheet data 

The “Floors” are interpreted as Stories in the ArchiCAD project. The story names (COBie “Name”), the 
elevation (COBie “Elevation”) and the height (COBie “Height”) can be defined in the Story Settings dialog 
(Design > Story Settings). 

 

Figure 10   Story settings define the major COBie Floor data in ArchiCAD 

To set the Floor “Category”, choose the proper “Floor Type” Classification Reference data in the IFC 
Manager. Just choose the “COBie Floor and Zone Categories” (Floor Types) predefined rule with the Apply 
Predefined Rule tool. The “Description” attribute of an ArchiCAD Story (IfcBuildingStorey) can also be set via 
the IFC Manager. 
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Figure 11   Floor Type definition in the IFC Manager 
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Space 
The COBie2 Space worksheet summarizes data of the Spaces (IfcSpace) of the project. 

 

Figure 12   Mapping between ArchiCAD model and the COBie2 Space worksheet data 

The “Spaces” are interpreted as Zones (IfcSpaces) in the ArchiCAD project. Thus, the COBie2-required data 
can be set in ArchiCAD Zone Settings. IFC data can be set using the Manage IFC Properties option (Tags and 
Categories tab). 

Note Each COBie Space (ArchiCAD Zone) has to have a unique COBie “Name”, that is, a unique ArchiCAD 
Zone “No” (Number). 

 

Figure 13   Space settings in ArchiCAD 
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To set the Space “Category”, select the proper Classification Reference data in the Zone Settings dialog (Tags 
and Categories > Manage IFC Properties) or in the IFC Manager. COBie requires IfcSpace classification by the 
OmniClass table 13 called “Space by Function”(in the U.S.) or by the Uniclass system (in UK). Both systems 
are available as built-in classification rules in ArchiCAD under the Apply Predefined Rule option. 

 

Figure 14   Space Category definition 
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Zone 
The COBie2 Zone worksheet summarizes the sets of spaces sharing a specific attribute in the project. In 
other words, it summarizes the data of the groups (IfcZones) of COBie Spaces (IfcSpaces). 

 

Figure 15   Mapping between ArchiCAD model and the COBie2 Zone worksheet data 

COBie “Zones” are interpreted as IFC Zone Assignment (IfcZone) entities in the ArchiCAD project. An IfcZone 
entity is a group of ArchiCAD Zone (IfcSpace) entities. IFC Zone entities with their COBie2-required data can 
be defined and managed only in the IFC Manager. 

A COBie “Zone” (IfcZone) can be defined with the New command by applying it to the “IFC Zones” member 
of the “Assignments” tree. Set the COBie “Name” and the “Description” data at the attributes of the same 
name. 

To set the Zone “Category”, choose the proper “Zone Type” Classification Reference data in the IFC 
Manager. Just choose the “COBie Floor and Zone Categories” (Zone Types) predefined rule with the Apply 
Predefined Rule tool. 

 

Figure 16   COBie2 Zone (IFC Zone) definition in the IFC Manager 
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To assign several ArchiCAD Zones (IfcSpaces) having the same function (for example circulation zones) to a 
newly created IFC Zone entity, just drag and drop them to the “New Relation” folder of the IFC Zone entity. 

 

Figure 17   Grouping ArchiCAD Zones in an IFC Zone 

Note Hotlinked ArchiCAD Zone entities cannot be grouped in IFC Zones. To assign an IFC Zone entity to 
these Zones, you must first break their Hotlink module connection. 
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Type 
COBie2 Type worksheet summarizes the types of equipment and products. 

 

Figure 18   Mapping between ArchiCAD model and the COBie2 Type worksheet data 

COBie “Types” are interpreted as IFC Type Product entities in the ArchiCAD project. IFC Type Products and 
their COBie2-requested data can be defined in the IFC Manager only. ArchiCAD automatically generates IFC 
Type Product entities for all ArchiCAD element types. The following table shows naming examples of the 
automatically generated IFC Type Products. 

 

Figure 19   Naming rule examples of IFC Type Product entities 
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In the Scheme Setup (File > File Special > IFC 2x3) command dialog, you can override the Type naming with 
mapping rules. For example, the COBie Scheme XML loaded into ArchiCAD gives a complex naming rule for 
IfcWindowStyle and IfcDoorStyle naming that contains the Library Part Name, the Building Material, the 
Width and Height parameters and some static texts among the data values. 

 

Figure 20   Name mapping by the IFC Scheme Setup command 

 

Figure 21   The effect of the scheme-driven WindowStyle mapping 

Of course, Type names can be modified manually. To modify the predefined name of a Type and/or to 
manage the COBie-required attributes, properties and classification reference (COBie Category) of a Type, 
first you have to set IFC Type Product entity to be editable. Apply the Edit/New Type command on the 
selected Type Product item, and manage its properties in its property table (right hand side). 
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Figure 22   How to make a Type Product entity editable 

If an IFC Type Product is editable, the following functions become available: 

- renaming (modification of the “Name” attribute), 
- setting COBie attributes and properties, 
- setting Type Category, and 
- modifying its member content by moving the members into another type. 

To set the Type “Category”, select the proper Classification Reference data in the IFC Manager. COBie 
requires IFC Type Product classification by the OmniClass table 23 called “Products” (in the U.S.) or by the 
Uniclass system (in UK). Both systems are available as built-in classification rules in ArchiCAD under the Apply 
Predefined Rule option. 
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Figure 23   COBie Category definition for Window Style entity 

The COBie-required duration unit can be set in Export Options. There is a predefined settings package (so-
called “IFC Translation Setup” in ArchiCAD) which contains export options optimized for the COBie-required 
IFC export. It is called “COBie 2 Export” IFC Translator (see chapter COBie2-enabled IFC Model Export). 

Note If you create a new Component in your model after Type definition, you can easily drag and drop the 
new Component onto an edited Type in the Type Products dialog of the IFC Manager. 

 If you have same type Components in two different Hotlinked modules, you can unify them in one 
common Type (within one COBie Type ExtIdentifier (IFC GlobalId)) only after you break their Hotlink 
module connection. 
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Component 
The COBie2 Component worksheet summarizes the individually named items of the project. 

 

Figure 24   Mapping between ArchiCAD model and the COBie2 Component worksheet data 

The “Name” data are derived from the ArchiCAD “ID” of the element, so you can set them in the element 
Settings dialogs. All IFC data can be set using the Manage IFC Properties option (Tags and Categories tab) of 
the Settings dialog or in the IFC Manager. 

Note Each Component has to have a unique COBie “Name” (ArchiCAD “ID”). If you did not assign unique 
(different) ID’s to your ArchiCAD elements, you can do so at any time, for example using the Element 
ID Manager function (Document > Schedules and Lists). 

The “Space” data describes the ArchiCAD Zone (IfcSpace) assigned to a Component. This data is 
automatically calculated, if the IFC export uses the Space containment and the IFC Space boundaries 
functions (see chapter COBie2-enabled IFC Model Export). 
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Figure 25   COBie-required Component data set in the ‘Window Settings’ dialog 
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System 
The COBie2 System worksheet summarizes the sets of Components providing a service. In other words, it 
summarizes the data of the systems (IfcSystem) of the project elements. 

 

Figure 26   Mapping between ArchiCAD model and the COBie2 System worksheet data 

COBie “Systems” are interpreted as IFC System Assignment (IfcSystem) entities in the ArchiCAD project. An 
IfcSystem entity is a group of ArchiCAD elements. IFC System entities with their COBie2-required data can be 
defined and managed only in the IFC Manager. 

A COBie “System” (IfcSystem) can be defined with the New command by applying it to the “IFC Systems” 
member of the “Assignments” tree. Set the COBie “Name” and the “Description” using the attribute fields of 
the same name. 

To set the System “Category”, select proper Classification Reference data in the IFC Manager. COBie requires 
IFC System classification by the OmniClass table 21 called “Elements” (in the U.S.) or by the Uniclass system 
(in UK). Both systems are available as built-in classification rules in ArchiCAD under the Apply Predefined Rule 
option. 

 

Figure 27   COBie2 System (IFC System) definition in the IFC Manager 
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To assign ArchiCAD elements having the same function (for example elevators) to a newly created IFC 
System entity, just drag and drop them to the “New Relation” folder of the IFC System entity. 

 

Figure 28   Grouping ArchiCAD elements in an IFC System 

Note Hotlinked Components (ArchiCAD elements) cannot be grouped in IFC Systems. To assign an IFC 
System entity to these elements, you must break their Hotlink module connection. 

MEP Systems defined with the GRAPHISOFT MEP Modeler Add-On can be also handled as IfcSystem inside 
an ArchiCAD project. Just create a new IfcSystem (as mentioned above) and choose the predefined MEP 
System name from the available list . 

If an IFC model exported by an MEP application is merged to an ArchiCAD project, you can also manage its 
MEP systems and their properties in the IFC Manager. 

http://www.graphisoft.com/archicad/mep_modeler/
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Figure 29   Conversion of a MEP Modeler System to an IFC System 

 

Document / Attribute / Coordinate / PickLists 
Data are extracted automatically from the IFC model exported by ArchiCAD. 

 

Assembly / Connection / Spare / Resource / Job / Impact / Issue 
These data types are not requested from a design application by the COBie2 rules, and they are not available 
in ArchiCAD projects either. The table contents should be manually filled out in the spreadsheet, if they are 
required. 
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COBie2-enabled IFC Model Export 
 

The COBie-required IFC model/file can be exported easily by using the export set (so-called “IFC Translator”) 
optimized for the COBie 2 requirements. Just use the Save as command (File menu) together with the 
translator called “COBie 2 Export” from either a Floor Plan or a 3D window. 

 

Figure 30   IFC model export optimized for COBie 2 requirements 

The steps of IFC model export to COBie 2: 

1. Filter elements for the export (use the following options): 
- Selected elements only (available only if elements have been selected): 

elements selected in the current view (the view that was open when you issued the “Save as” 
command) will be exported. 

- Entire project: 
entire model (regardless of any selection, and regardless of the shown/hidden status of the 
elements’ layers) will be exported. 

- Visible elements: 
the visible elements in the current view will be exported, regardless of any selection. “Visible” 
means all elements that are set to be displayed (due to Layer Settings, model view options, 
Partial Structure Display, etc.). 

Note If you issue the export command from Floor Plan view (“Visible elements (on all stories)”), 
this choice includes all elements currently displayed on every story of the project. 

If you choose “Visible elements”, make sure that ArchiCAD Zones are set to be displayed in 
the current view. For example, if you are saving from the 3D window, make sure that 
Zones are “on” in the Filter and Cut Elements in 3D dialog box (View > Elements in 3D 
View). 

2. Choose the “COBie 2 Export” Translator, in which export settings are fine-tuned for the COBie2 
requirements. The meaning of the major Export Options (“Derived model data to export” options) of 
the “COBie 2 Export” Translator is the following (check Settings): 
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- Space containment: 
It exports the relationship between ArchiCAD Zones (IfcSpaces) and their contained Object 
(Furnishing, MEP Equipment, etc.) and Morph elements. “Contained” means that the midpoint 
of an Object or Morph is within an ArchiCAD Zone in the 3D space. This option is required for 
exporting COBie “Space” data of the Component worksheet. 

- Base quantities (size, area and volume): 
It exports elements’ base quantities required by COBie2. 

- IFC Space boundaries: 
It exports the logical connection between ArchiCAD Zones (IfcSpace) and the building elements 
that enclose them. This option is also required for exporting COBie “Space” data of the 
Component worksheet. 
 

 

Figure 31   Major export options of the “COBie 2 Export” IFC Translator 

3. Set the model units. 
 

4. Define file name. 
 

5. Set the file format to .IFC (or .IFCXML depending on the file support of the COBie 2 spreadsheet 
converter programs). See the How to Create a COBie2 Spreadsheet chapter. 
 

6. Click Save.  
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How to Create a COBie2 Spreadsheet 
 

An external application is needed to convert an ArchiCAD IFC file to an XML-type COBie 2 spreadsheet 
format. 

The IFC and COBie2 spreadsheet formats for the IFC 2x3 Basic FM Handover MVD capture the same 
information content and can be transformed forth and back across the different formats. COBie from IFC 
transformations are implemented according to the so-called “COBie Responsibility Matrix” document. This 
document defines the mapping rules between the IFC file and the COBie spreadsheet and which IFC entity 
types are allowed to be converted to COBie Component and Type entities (“Type Assets” and “Component 
Assets” tables). 

A number of dedicated tools can be used to execute the transformations, such as the free COBie Toolkit 
application, developed by Engineer Research and Development Center (ERDC). The COBie Toolkit can be 
downloaded from here. 

ERDC COBie Toolkit, developed for the COBie FM Handover project, includes the transformer tool and the 
configurations to map IFC data to COBie2. The conversion can be done in two easy steps. 

 

Figure 32   The steps of IFC to COBie conversion 

Hint If you choose the “COBie QC Report - Design Deliverable” export format, the application checks for 
any missing items in your IFC model. This quality check presents a summary of various checks 
performed on the COBie data: e.g. at least one Component for each Type, unique names for Types, 
at least one Floor, etc. 

In case of very large IFC models, modify the memory options (by increasing the Max Heap, Max Perm 
and Stack Size) in the COBie Toolkit Starter dialog. 

 

Figure 33   An example for memory settings 

http://projects.buildingsmartalliance.org/files/?artifact_id=5466
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Based on the COBie Responsibility Matrix (“Type Assets” and “Component Assets” tables), the COBie 
Toolkit ignores some IFC entity types (e.g. IfcWallType, IfcWall, IfcWallStandardCase) by default. If 
you would like to allow all IFC entity type conversion to COBie Types and Components, change the 
“COBieIDMPlugin” mode to “None” at “Options”. 

 

Figure 34   IFC Entity and Type Products ignored in the IFC to COBie conversion by default 
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